MDI Applications CHAPTER

IN THIS CHAPTER

. Creating the MDI Application 240
e  Working with Menus 272
. Miscellaneous MDI Techniques 273

= Summary 287



240

Advanced Techniques

PART I

The Multiple Document Interface, otherwise known as MDI, was introduced to Windows 2.0 in
the Microsoft Excel spreadsheet program. MDI gave Excel users the ability to work on more
than one spreadsheet at atime. Other uses of MDI included the Windows 3.1 Program
Manager and File Manager programs. Borland Pascal for Windows is another M DI application.

During the development of Windows 95, many developers were under the impression that
Microsoft was going to eliminate MDI capabilities. Much to their surprise, Microsoft kept
MDI as part of Windows 95 and there has been no further word about Microsoft’s intention to
get rid of it.

CAUTION

Microsoft has acknowledged that the Windows MDI implementation is flawed. It
advised developers against continuing to build apps in the MDI model. Since then,
Microsoft has returned to building MS apps in the MDI model but does so without
using the Windows MDI implementation. You can still use MDI, but be forewarned
that the Windows MDI implementation is still flawed, and Microsoft has no plans to
fix those problems. What we present in this chapter is a safe implementation of the
MDI model.

Handling events simultaneously between multiple forms might seem difficult. In traditional
Windows programming, you had to have knowledge of the Windows class MDICLIENT, MDI
data structures, and the additional functions and messages specific to MDI. With Delphi 5, cre-
ating MDI applicationsis greatly simplified. When you finish this chapter, you'll have a solid
foundation for building MDI applications, which you can easily expand to include more
advanced techniques.

Creating the MDI Application

To create MDI applications, you need familiarity with the form styles fsMbIForm and
fsMDIChild and abit of MDI programming methodology. The following sections present some
basic concepts regarding MDI and show how MDI works with special MDI child forms.

Understanding MDI Basics

To understand MDI applications, first you must understand how they’re constructed. Figure
16.1 shows an MDI application similar to one you'll build in this chapter.
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The structure of an MDI application.

Here are the windows involved with an MDI application:

» Frame window. The application’s main window. It has a caption, menu bar, and system
menu. Minimize, maximize, and close buttons appear in its upper-right corner. The blank
space inside the frame window is known as its client area and is actually the client
window.

 Client window. The manager for MDI applications. The client window handles all MDI-
specific commands and manages the child windows that reside on its surface—including
the drawing of MDI child windows. The client is created automatically by the Visual
Component Library (VCL) when you create a frame window.

 Child windows. MDI child windows are your actual documents—text files, spreadsheets,
bitmaps, and other document types. Child windows, like frame windows, have a caption,
system menu, minimize, maximize, and close buttons, and possibly a menu. It's possible
to place a help button on a child window. A child window’s menu is combined with the
frame window’s menu. Child windows never move outside the client area.

Delphi 5 does not require you to be familiar with the special MDI window’s messages. The
client window is responsible for managing MDI functionality, such as cascading and tiling child
windows. To cascade child windows using the traditional method, for example, use the Windows
API function SendMessage () to send awm_MDICASCADE message to the client window:

procedure TFrameForm.Cascade1Click(Sender: TObject);
begin
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SendMessage (ClientHandle, WM_MDICASCADE, @, 0);
end;

In Delphi 5, just call the cascade () method:

procedure TFrameForm.Cascade1Click(Sender: TObject);
begin

cascade;
end;

The following sections show you a complete M DI application whose child MDI windows have
the functionality of atext editor, a bitmap file viewer, and arich text format editor. The pur-
pose of this application is to show you how to build MDI applications whose child windows
each display and edit different types of information. For example, the text editor allows you to
edit any text-based file. The rich text editor allows you to edit rich text—formatted (. rtf) files.
Finally, the bitmap viewer alows you to view any Windows bitmapped file.

We also show you how to perform some advanced MDI techniques using the Win32 API.
These techniques mainly have to do with managing MDI child forms in an MDI-based applica-
tion. First, we'll discuss the building of the child forms and their functionality. Then we'll talk
about the main form.

The Child Form

As mentioned earlier, this MDI application contains three types of child forms: TMdiEditForm,
TMdiRTFForm, and TMdiBMPForm. Each of these three types descends from TMDIChildForm,
which serves as a base class. The following section describes the TMDIChildForm base class.
The sections after that talk about the three child forms used in the MDI application.

The TMDIChildForm Base Class

The child forms used in the M DI application have some common functionality. They all have
the same File menu and their FormStyle property is set to fsMpICchild. Additionally, they all
make use of a TToo1Bar component. By deriving each child form from a base form class, you
can avoid having to redefine these settings for each form. We defined a base form,
TMDIChildForm, & shown in MdiChildFrm.pas (refer to Listing 16.1).

LisTING 16.1 MdiChildFrm.pas: A Unit Defining TMDIChildForm

unit MdiChildFrm;
interface
uses

SysUtils, Windows, Messages, Classes, Graphics, Controls,
Forms, Dialogs, Menus, ComCtrls, ToolWin, ImgList;
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type

TMDIChildForm = class(TForm)

(* Component list removed, refer to online source. *)
procedure FormClose(Sender: TObject; var Action: TCloseAction);
procedure mmiExitClick(Sender: TObject);
procedure mmiCloseClick(Sender: TObject);
procedure mmiOpenClick(Sender: TObject);
procedure mmiNewClick(Sender: TObject);
procedure FormActivate(Sender: TObject);
procedure FormDeactivate(Sender: TObject);

end;

var
MDIChildForm: TMDIChildForm;

implementation
uses MainFrm, Printers;

{$R *.DFM}

procedure TMDIChildForm.FormClose(Sender: TObject; var Action: TCloseAction);
begin
Action := caFree;
{ Reassign the toolbar parent }
tlbMain.Parent := self;
{ If this is the last child form being displayed, then make the main form's
toolbar visible }
if (MainForm.MDIChildCount = 1) then
MainForm.tlbMain.Visible := True
end;

procedure TMDIChildForm.mmiExitClick(Sender: TObject);
begin

MainForm.Close;
end;

procedure TMDIChildForm.mmiCloseClick(Sender: TObject);
begin

Close;
end;

procedure TMDIChildForm.mmiOpenClick(Sender: TObject);
begin

MainForm.mmiOpenClick(nil);
end;

continues
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LisTING 16.1 Continued

procedure TMDIChildForm.mmiNewClick(Sender: TObject);
begin

MainForm.mmiNewClick(nil);
end;

procedure TMDIChildForm.FormActivate(Sender: TObject);
begin
{ When the form becomes active, hide the main form's toolbar and assign
this child form's toolbar to the parent form. Then display this
child form's toolbar. }

MainForm.tlbMain.Visible := False;
tlbMain.Parent := MainForm;
tlbMain.Visible := True;

end;

procedure TMDIChildForm.FormDeactivate(Sender: TObject);
begin
{ The child form becomes inactive when it is either destroyed or when another
child form becomes active. Hide this form's toolbar so that the next
form's
toolbar will be visible. }
tlbMain.Visible := False;
end;

end.

NoOTE

Note that we have removed the component declarations for the TMdiChildForm base
class from the printed text for space reasons.

TMDIChildForm contains event handlers for the menu items for its main menu as well as for
some common tool buttons. Actually, the tool buttons are simply wired to the event handler of
their corresponding menu item. Some of these event handlers call methods on the main form.
For example, notice that the mmiNewClick () event handler calls the MainForm.mmiNewClick ()
event handler. TMainForm.mmiNewClick () contains functionality for creating a new MDI child
form. You'll notice that there are other event handlers such as mmiopenClick() and
mmiExitClick () that call the respective event handlers on the main form. We'll cover
TMainForm’'s functionality later in the section “The Main Form.”

Because each MDI child needs to have the same functionality, it makes sense to put this func-
tionality into a base class from which the MDI child forms can descend. This way, the MDI
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child forms do not have to define these same methods. They will inherit the main menu as well 16

as the toolbar components that you see on the main form.

Notice in the TMDIChildForm.FormClose () event handler that you set the Action parameter to
caFree to ensure that the TMDIChildForm instance is destroyed when closed. You do this
because MDI child forms don't close automatically when you call their close () method. You
must specify, in the onclose event handler, what you want done with the child form when its
Close() method is called. The child form’s onCclose event handler passesin avariable Action,
of type TCloseAction, to which you must assign one of four possible values:
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AN

* caNone. Do nothing.

¢ caHide. Hide the form but don’t destroy it.

* caFree. Free the form.

e caMinimize. Minimize the form (thisis the default).
TCloseAction iSan enumerated type.

When a form becomes active, its onActivate event handler is called. You must perform some
specific logic whenever a child form becomes active. Therefore, in the TMdiChildForm.
FormActivate() event handler, you'll see that we make the main form’s toolbar invisible while
setting the child form’s toolbar to visible. We also assign the main form as the parent to the
child form’s toolbar so that the toolbar appears on the main form and not on the child form.
Thisis one way you might give the main form a different toolbar when a different type of MDI
child form is active. The onDeactivate event handler simply makes the child form’s tool bar
invisible. Finally, the onClose event reassigns the child form as the parent to the toolbar, and if
the current child form is the only child form, it makes the main form'’s toolbar visible. The
effect is that the main form has a single toolbar with buttons that change depending on the type
of active child form.

The Text Editor Form
The text editor form enables the user to load and edit any text file. Thisform, TMdiEditForm, is
inherited from TMDIChildForm. TMdiEditForm contains a client-aligned TMemo component.

TMdiEditForm alSO contains TPrintDialogs, TSaveDialog and TFontDialog coOmponents.

TMdiEditForm is not an autocreated form and is removed from the list of autocreated formsin
the Project Options dialog box.

NoTE

None of the forms, except for TMainForm, in the MDI project are automatically cre-
ated and therefore have been removed from the list of autocreated forms. These
forms are created dynamically in the project’s source code.
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TMdiEditForm’s source codeis givenin Listing 16.2.

LISTING 16.2 MdiEditFrm.pas: A Unit Defining TMdiEditForm

unit MdiEditFrm;
interface

uses
SysUtils, Windows, Messages, Classes, Graphics, Controls,
Forms, Dialogs, StdCtrls, Menus, ExtCtrls, Buttons, ComCtrls,
ToolWin, MdiChildFrm, ImgList;

type

TMdiEditForm = class(TMDIChildForm)
memMainMemo: TMemo;
SaveDialog: TSaveDialog;
FontDialog: TFontDialog;
mmiEdit: TMenulItem;
mmiSelectAll: TMenultem;
N7: TMenultem;
mmiDelete: TMenuItem;
mmiPaste: TMenuItem;
mmiCopy: TMenuItem;
mmiCut: TMenuItem;
mmiCharacter: TMenulItem;
mmiFont: TMenuItem;

N8: TMenultem;
mmiWordWrap: TMenuItem;
N9: TMenultem;
mmiCenter: TMenuItem;
mmiRight: TMenuItem;
mmiLeft: TMenuItem;
mmiUndo: TMenuItem;

N4: TMenultem;

mmiBold: TMenulItem;
mmiItalic: TMenuItem;
mmiUnderline: TMenuItem;
PrintDialog: TPrintDialog;

{ File Event Handlers }
procedure mmiSaveClick(Sender: TObject);
procedure mmiSaveAsClick(Sender: TObject);
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{ Edit Event Handlers } 16
procedure mmiCutClick(Sender: TObject);
procedure mmiCopyClick(Sender: TObject);
procedure mmiPasteClick(Sender: TObject); %;
procedure mmiDeleteClick(Sender: TObject); g
procedure mmiUndoClick(Sender: TObject); g
procedure mmiSelectAllClick(Sender: TObject); g
w
{ Character Event Handlers }
procedure CharAlignClick(Sender: TObject);
procedure mmiBoldClick(Sender: TObject);
procedure mmiItalicClick(Sender: TObject);
procedure mmiUnderlineClick(Sender: TObject);
procedure mmiWordWrapClick(Sender: TObject);
procedure mmiFontClick(Sender: TObject);
{ Form Event Handlers }
procedure FormCloseQuery(Sender: TObject; var CanClose: Boolean);
procedure mmiPrintClick(Sender: TObject);
public
{ User Defined Methods }
procedure OpenFile(FileName: String);
procedure SetButtons;
end;
var
MdiEditForm: TMdiEditForm;
implementation
uses Printers;
{$R *.DFM}
{ File Event Handlers }
procedure TMdiEditForm.mmiSaveClick(Sender: TObject);
begin
inherited;
{ If there isn't a caption, then there isn't already a filename.
Therefore, call mmiSaveAsClick since it gets a filename. }
if Caption = '' then
mmiSaveAsClick(nil)
else begin
{ Save to the file specified by the form's Caption. }
memMainMemo.Lines.SaveToFile(Caption);
memMainMemo.Modified := false; // Set to false since the text is saved.

continues

AN
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LisTING 16.2 Continued

end;
end;

procedure TMdiEditForm.mmiSaveAsClick(Sender: TObject);

begin
inherited;
SaveDialog.FileName := Caption;
if SaveDialog.Execute then
begin

{ Set caption to filename specified by SaveDialogl since this
may have changed. }

Caption := SaveDialog.FileName;
mmiSaveClick(nil); // Save the file.
end;

end;
{ Edit Event Handlers }

procedure TMdiEditForm.mmiCutClick(Sender: TObject);
begin

inherited;

memMainMemo.CutToClipBoard;
end;

procedure TMdiEditForm.mmiCopyClick(Sender: TObject);
begin

inherited;

memMainMemo.CopyToClipBoard;
end;

procedure TMdiEditForm.mmiPasteClick(Sender: TObject);
begin

inherited;

memMainMemo.PasteFromClipBoard;
end;

procedure TMdiEditForm.mmiDeleteClick(Sender: TObject);
begin

inherited;

memMainMemo.ClearSelection;
end;

procedure TMdiEditForm.mmiUndoClick(Sender: TObject);
begin
inherited;



MDI Applications

249

memMainMemo.Perform(EM_UNDO, @, 0);
end;

procedure TMdiEditForm.mmiSelectAllClick(Sender: TObject);
begin

inherited;

memMainMemo.SelectAll;
end;

{ Character Event Handlers }
procedure TMdiEditForm.CharAlignClick(Sender: TObject);
begin

inherited;

mmilLeft.Checked := false;

mmiRight.Checked := false;

mmiCenter.Checked := false;

{ TAlignment is defined by VCL as:

TAlignment = (taLeftJustify, taRightJdustify, taCenter);

CHAPTER 16
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Therefore each of the menu items contains the appropriate Tag property

whose value represents one of the TAlignment values: 0, 1, 2 }

{ If the menu invoked this event handler, set it to checked and
set the alignment for the memo }

if Sender is TMenuItem then

begin
TMenuItem(Sender).Checked := true;
memMainMemo.Alignment := TAlignment(TMenuIltem(Sender).Tag);

end

{ If a TToolButton from the main form invoked this event handler,

set the memo's alignment and then check the appropriate TMenuItem.

else if Sender is TToolButton then
begin
memMainMemo.Alignment := TAlignment(TToolButton(Sender).Tag);
case memMainMemo.Alignment of
taLeftdustify: mmilLeft.Checked := True;
taRightJustify: mmiRight.Checked := True;
taCenter: mmiCenter.Checked := True;
end;
end;
SetButtons;
end;

procedure TMdiEditForm.mmiBoldClick(Sender: TObject);

}

continues
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LisTING 16.2 Continued

begin
inherited;
if not mmiBold.Checked then
memMainMemo.Font.Style := memMainMemo.Font.Style + [fsBold]
else
memMainMemo.Font.Style := memMainMemo.Font.Style - [fsBold];
SetButtons;
end;

procedure TMdiEditForm.mmiItalicClick(Sender: TObject);

begin
inherited;
if not mmiItalic.Checked then
memMainMemo.Font.Style := memMainMemo.Font.Style + [fsItalic]
else
memMainMemo.Font.Style := memMainMemo.Font.Style - [fsItalic];
SetButtons;
end;

procedure TMdiEditForm.mmiUnderlineClick(Sender: TObject);

begin
inherited;
if not mmiUnderline.Checked then
memMainMemo.Font.Style := memMainMemo.Font.Style + [fsUnderline]
else
memMainMemo.Font.Style := memMainMemo.Font.Style - [fsUnderline];
SetButtons;
end;

procedure TMdiEditForm.mmiWordWrapClick(Sender: TObject);
begin
inherited;
with memMainMemo do
begin
WordWrap := not WordWrap;
{ Remove scrollbars if Memo1 is wordwrapped since they're not
required. Otherwise, make sure scrollbars are present. }
if WordWrap then
ScrollBars := ssVertical
else
ScrollBars := ssBoth;
mmiWordWrap.Checked := WordWrap;
end;
end;

procedure TMdiEditForm.mmiFontClick(Sender: TObject);
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begin
inherited; 16
FontDialog.Font := memMainMemo.Font; >
if FontDialog.Execute then T
memMainMemo.Font := FontDialog.Font; g
end; 5
o
=z
w

{ Form Event Handlers }
procedure TMdiEditForm.FormCloseQuery(Sender: TObject;
var CanClose: Boolean);
{ This procedure ensures that the user has saved the contents of the
memo if it was modified since the last time the file was saved. }
const
CloseMsg =
var
MsgVal: integer;
FileName: string;

-S|
S

has been modified, Save?';

begin
inherited;
FileName := Caption;
if memMainMemo.Modified then
begin

MsgVal := MessageDlg(Format(CloseMsg, [FileName]), mtConfirmation,
mbYesNoCancel, 0);
case Msgval of

mryes: mmiSaveClick (Self);
mrCancel: CanClose := false;
end;
end;
end;

procedure TMdiEditForm.OpenFile(FileName: string);

begin
memMainMemo.Lines.LoadFromFile (FileName) ;
Caption := FileName;

end;

procedure TMdiEditForm.SetButtons;
{ This procedure ensures that menu items and buttons on the main form
accurately reflect various settings for the memo. }

begin
mmiBold.Checked := fsBold in memMainMemo.Font.Style;
mmiltalic.Checked := fsItalic in memMainMemo.Font.Style;
mmiUnderLine.Checked := fsUnderline in memMainMemo.Font.Style;
tbBold.Down := mmiBold.Checked;

continues

AN
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LisTING 16.2 Continued

tbItalic.Down := mmiItalic.Checked;

tbUnderline.Down := mmiUnderLine.Checked;

tbLAlign.Down := mmiLeft.Checked;

tbRAlign.Down := mmiRight.Checked;

tbCAlign.Down := mmiCenter.Checked;
end;

procedure TMdiEditForm.mmiPrintClick(Sender: TObject);
var
i: integer;
PText: TextFile;
begin
inherited;
if PrintDialog.Execute then
begin
AssignPrn(PText);
Rewrite(PText);
try
Printer.Canvas.Font := memMainMemo.Font;
for i := @ to memMainMemo.Lines.Count -1 do
writeln(PText, memMainMemo.Lines[i]);
finally
CloseFile(PText);
end;
end;
end;

end.

Most of the methods for TMdiEditForm are event handlers for the various menusin
TMdiEditForm’'s main menu, the same menu inherited from TMdiChildForm. Also notice that
additional menu items have been added to the main menu that apply specificaly to
TMdiEditForm.

You'll notice that there are no event handlers for the File, New, File, Open, File, Close, and
File, Exit menus because they're already linked to TMdiChildForm's event handlers.

The event handlers for the Edit menu items are al single-line methods that interact with the
TMemo component. For example, you'll notice that the event handlers mmiCutClick(),
mmiCopyClick (), and mmiPasteClick() interact with the Windows Clipboard in order to per-
form cut, copy, and paste operations. The other edit event handlers perform various editing
functions on the memo component that have to do with deleting, clearing, and selecting text.
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The Character menu applies various formatting attributes to the memo. 1

»

Notice that we stored a unique value in the Tag property of the TToo1Button components for
setting text alignment. This Tag value represents a value in the TAlignment enumerated type.
This value is extracted from the Tag value of the TToo1Button component that invoked the
event handler to set the appropriate alignment for the memo component.
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All menu items and tool buttons that set text alignment are wired to the CharAlignClick ()
event handler. Thisis why you have to check and respond appropriately in the event handler
depending on whether a TMenuItem or TToolButton component invoked the event.

CharAlignClick() callsthe setButtons() method, which sets various menu items and com-
ponents accordingly based on the memo’s attributes.

The mmiWordwrapClick () event handler simply toggles the memo’s wordwrap attribute and
then the checked property for the menu item. This method also specifies whether the memo
component contains scrollbars based on its word-wrapping capability.

ThemmiFontClick() event handler invokes a TFontDialog component and applies the selected
font to the memo. Notice that before launching the FontDialog component, the Font property
is set to reflect the memo’s font so that the correct font is displayed in the dialog box.

ThemmiSaveAsClick () event handler invokes a TSaveDialog component to get afilename
from the user to which the memo’s contents will be saved. When the file is saved, the
TMdiEditForm.Caption property is set to reflect the new filename.

ThemmiSaveClick() event handler callsthe mmiSaveAsClick () event handler if afilename
doesn’t exist. Thisisthe case if the user creates a new file instead of opening an existing one.
Otherwise, the memo’s contents are saved to the existing file specified by the
MdiEditForm.Caption property. Notice that this event handler also sets
memMainMemo.Modified tO False. Modified isautomatically set to True whenever the user
changes the contents of a TMemo component. However, it's not set to False automatically
whenever its contents are saved.

The FormCloseQuery () method is the event handler for the onCloseQuery event. This event
handler evaluates the memMainMemo .Modified property when the user attempts to close the
form. If the memo has been modified, the user is notified and asked whether he or she wants to
save the contents of the memo.

The public method TMdiEditForm.OpenFile () loads the file specified by the FileName para-
meter and places the file's contents into the memMainMemo . Lines property and then sets the
form’s caption to reflect this filename.

That compl etes the functionality for TMdiEditForm. The other forms are somewhat similar in
functionality.
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The Rich Text Editor Form
Therich text editor enables the user to load and edit rich text—formatted files. This form,
TMdiRtfForm, is derived from TMDIChild. It contains a client-aligned TRichEdit component.

TMdiRtfForm and TMdiEditForm are practically identical except that TMdiRtfForm contains a
TRichEdit component as its editor; TMdiEditForm USES & TMemo component. TMdiRtfForm dif-
fers from the text editor in that the text attributes applied to the TRichEdit component affect
paragraphs or selected text in the TRichEdit component; they affect the entire text with the
TMemo component.

The source code for TMdiRtfForm isshown in Listing 16.3.

LisTING 16.3  MdiRtfFrm.pas: A Unit Defining TMdiRtfForm

unit MdiRtfFrm;
interface

uses
SysUtils, Windows, Messages, Classes, Graphics, Controls,
Forms, Dialogs, MdiChildFrm, StdCtrls, ComCtrls,
ExtCtrls, Buttons, Menus, ToolWin, ImgList;

type

TMdiRtfForm = class(TMDIChildForm)
reMain: TRichEdit;
FontDialog: TFontDialog;
SaveDialog: TSaveDialog;
mmiEdit: TMenuItem;
mmiSelectAll: TMenultem;
N7: TMenultem;
mmiPaste: TMenuItem;
mmiCopy: TMenultem;
mmiCut: TMenuItem;
mmiCharacter: TMenultem;
mmiFont: TMenuItem;

N8: TMenultem;
mmiWordWrap: TMenuItem;
N9: TMenultem;
mmiCenter: TMenuItem;
mmiRight: TMenuItem;
mmiLeft: TMenuItem;
mmiUndo: TMenuItem;
mmiDelete: TMenulItem;
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N4: TMenultem;
mmiBold: TMenuItem;

mmiItalic

: TMenuItem;

mmiUnderline: TMenultem;

{ File Event Handlers }

procedure
procedure

mmiSaveClick(Sender: TObject);
mmiSaveAsClick(Sender: TObject);

{ Edit Event Handlers }

procedure
procedure
procedure
procedure
procedure
procedure

mmiCutClick (Sender: TObject);
mmiCopyClick(Sender: TObject);
mmiPasteClick(Sender: TObject);
mmiDeleteClick(Sender: TObject);
mmiUndoClick (Sender: TObject);
mmiSelectAllClick(Sender: TObject);

{ Character Event Handlers }

procedure
procedure
procedure
procedure
procedure
procedure

CharAlignClick(Sender: TObject);
mmiBoldClick (Sender: TObject);
mmiltalicClick(Sender: TObject);
mmiUnderlineClick(Sender: TObject);
mmiWordWrapClick (Sender: TObject);
mmiFontClick (Sender: TObject);

{ Form Event Handlers }

procedure
procedure
procedure
procedure
public

FormShow(Sender: TObject);

CHAPTER 16

FormCloseQuery(Sender: TObject; var CanClose: Boolean);

reMainSelectionChange(Sender: TObject);
mmiPrintClick (Sender: TObject);

{ User-Defined Functions. }

procedure

OpenFile(FileName: String);

function GetCurrentText: TTextAttributes;

procedure
end;

var

SetButtons;

MdiRtfForm: TMdiRtfForm;

implementation

{$R *.DFM}

{ File Event Handlers }

procedure TMdiRtfForm.mmiSaveClick(Sender: TObject);

begin

continues

255
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LisTING 16.2 Continued

inherited;
reMain.Lines.SaveToFile(Caption);
end;

procedure TMdiRtfForm.mmiSaveAsClick(Sender: TObject);

begin
inherited;
SaveDialog.FileName := Caption;
if SaveDialog.Execute then
begin
Caption := SaveDialog.FileName;
mmiSaveClick (Sender);
end;
end;

{ Edit Event Handlers }

procedure TMdiRtfForm.mmiCutClick(Sender: TObject);
begin

inherited;

reMain.CutToClipBoard;
end;

procedure TMdiRtfForm.mmiCopyClick(Sender: TObject);
begin

inherited;

reMain.CopyToClipBoard;
end;

procedure TMdiRtfForm.mmiPasteClick(Sender: TObject);
begin

inherited;

reMain.PasteFromClipBoard;
end;

procedure TMdiRtfForm.mmiDeleteClick(Sender: TObject);
begin

inherited;

reMain.ClearSelection;
end;

procedure TMdiRtfForm.mmiUndoClick(Sender: TObject);
begin

inherited;

reMain.Perform(EM_UNDO, 0, 0);
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end;

procedure TMdiRtfForm.mmiSelectAllClick(Sender: TObject);
begin

inherited;

reMain.SelectAll;
end;

{ Character Event Handlers }

procedure TMdiRtfForm.CharAlignClick(Sender: TObject);
begin

inherited;

mmilLeft.Checked := false;

mmiRight.Checked := false;

mmiCenter.Checked := false;

{ If a TMenultem invoked this event handler, set its checked
property to true and set the attribute to RichEdit1's current
paragraph. }

if Sender is TMenuItem then

begin
TMenuItem(Sender).Checked := true;
with reMain.Paragraph do

if mmiLeft.Checked then
Alignment := talLeftJustify

else if mmiRight.Checked then
Alignment := taRightJustify

else if mmiCenter.Checked then
Alignment := taCenter;

end

{ If one of the main form's tool buttons invoked this event handler
set the attribute to reMain's current paragraph and set the
alignment menu items accordingly. }

else if Sender is TSpeedButton then

begin
reMain.Paragraph.Alignment :=

TAlignment (TSpeedButton(Sender).Tag);
case reMain.Paragraph.Alignment of
taLeftJustify: mmiLeft.Checked := True;
taRightJustify: mmiRight.Checked := True;
taCenter: mmiCenter.Checked := True;
end;
end;
SetButtons;
end;

continues
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procedure TMdiRtfForm.mmiBoldClick(Sender: TObject);
begin
inherited;
if not mmiBold.Checked then
GetCurrentText.Style := GetCurrentText.Style + [fsBold]
else
GetCurrentText.Style := GetCurrentText.Style - [fsBold];
end;

procedure TMdiRtfForm.mmiItalicClick(Sender: TObject);
begin
inherited;
if not mmiItalic.Checked then
GetCurrentText.Style := GetCurrentText.Style + [fsItalic]
else
GetCurrentText.Style := GetCurrentText.Style - [fsItalic];
end;

procedure TMdiRtfForm.mmiUnderlineClick(Sender: TObject);
begin
inherited;
if not mmiUnderline.Checked then
GetCurrentText.Style := GetCurrentText.Style + [fsUnderline]
else
GetCurrentText.Style := GetCurrentText.Style - [fsUnderline];
end;

procedure TMdiRtfForm.mmiWordWrapClick(Sender: TObject);
begin
inherited;
with reMain do
begin
{ Remove scrollbars if Memo1 is wordwrapped since they're not
required. Otherwise, make sure scrollbars are present. }

WordWrap := not WordWrap; if WordWrap then
ScrollBars := ssVertical
else
ScrollBars := ssNone;
mmiWordWrap.Checked := WordWrap;
end;

end;

procedure TMdiRtfForm.mmiFontClick(Sender: TObject);
begin
inherited;
FontDialog.Font.Assign(reMain.SelAttributes);
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if FontDialog.Execute then
GetCurrentText.Assign(FontDialog.Font);
reMain.SetFocus;
end;

{ Form Event Handlers }

procedure TMdiRtfForm.FormShow(Sender: TObject);
begin

inherited;

reMainSelectionChange(nil);
end;

procedure TMdiRtfForm.FormCloseQuery(Sender: TObject;
var CanClose: Boolean);
{ This procedure ensures that the user has saved the contents of
reMain if it was modified since the last time the file was saved. }
const
CloseMsg =
var
MsgVal: integer;
FileName: string;

-S|
S

has been modified, Save?';

begin
inherited;
FileName := Caption;
if reMain.Modified then
begin

MsgVal := MessageDlg(Format(CloseMsg, [FileName]), mtConfirmation,
mbYesNoCancel, 0);
case Msgval of
mrYes: mmiSaveClick(Self);
mrCancel: CanClose := false;
end;
end;
end;

procedure TMdiRtfForm.reMainSelectionChange(Sender: TObject);
begin

inherited;

SetButtons;
end;

procedure TMdiRtfForm.OpenFile(FileName: String);
begin
reMain.Lines.LoadFromFile(FileName);

continues
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Caption := FileName;
end;

function TMdiRtfForm.GetCurrentText: TTextAttributes;
{ This procedure returns the text attributes of the current paragraph
or based on the selected text of reMain.}
begin
if reMain.SellLength > @ then
Result := reMain.SelAttributes
else
Result := reMain.DefAttributes;
end;

procedure TMdiRtfForm.SetButtons;
{ Ensures that the controls on the form reflect the
current attributes of the paragraph by looking at the paragraph
attributes themselves and setting the controls accordingly. }
begin

with reMain.Paragraph do

begin
mmilLeft.Checked := Alignment = talLeftJustify;
mmiRight.Checked := Alignment = taRightJustify;
mmiCenter.Checked := Alignment = taCenter;

end;

with reMain.SelAttributes do

begin
mmiBold.Checked := fsBold in Style;
mmilItalic.Checked := fsItalic in Style;

mmiUnderline.Checked := fsUnderline in Style;
end;
mmiWordWrap.Checked := reMain.WordWrap;
tbBold.Down := mmiBold.Checked;
tbItalic.Down := mmiItalic.Checked;
tbUnderline.Down := mmiUnderline.Checked;
tbLAlign.Down := mmiLeft.Checked;
tbRAlign.Down := mmiRight.Checked;
tbCAlign.Down := mmiCenter.Checked;

end;

procedure TMdiRtfForm.mmiPrintClick(Sender: TObject);
begin
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inherited;
reMain.Print(Caption);
end;

end.

Like TMdiEditForm, most of TMdiRtfForm's methods are event handlers for the various menu
items and tool buttons. These event handlers are similar to TMdiEditForm’s event handlers.

TMdiRtfForm’s File menu items invoke the File menu items of the TMdichildForm base class.
Recall that TMdichildForm isthe ancestor to TMdiRtfForm. The event handlers,
mmiSaveClick () and mmiSaveAsClick (), both call remain.Lines.SaveToFile() to save
reMain’s contents.

The event handlers for TMdiRtfForm’s Edit menu items are single-line methods similar to the
TMdiEditForm’s Edit menu event handlers except that these event handlers call methods applic-
able to remain. The method names are the same as the memo methods that perform the same
operations.

TMdiRtfForm's Character menu items modify the alignment of paragraphs or selected text
within the TRichEdit component (as opposed to the text within the entire component, asis the
behavior with a TMemo component). Whether these attributes are applied to a paragraph or to
selected text depends on the return value of the GetCurrentText () function.

GetCurrentText () determines whether any text is selected by looking at the value of
TRichEdit.SellLength. A zero value indicates that no text is selected. The
TRichEdit.SelAttributes property refersto any selected text in the TRichEdit component.
TRichEdit.DefAttributes refersto the current paragraph of the TRichEdit component.

The mmiFontClick () event handler allows the user to specify font attributes for a paragraph.
Note that a paragraph can also refer to selected text.

Word wrapping is handled the same with the TRichEdit component as with the TMemo compo-
nent in the text editor.

The TRichEdit.OnSelectionChange event handler is available to allow the programmer to
provide some functionality whenever the selection of the component has changed. When the
user moves the caret within the TRichEdit component, the component’s SelStart property
value changes. Because this action causes the onSelectionChange event handler to be called,
code was added to change the status of the various TMenuItem and TSpeedButton components
on the main form to reflect the attributes of the text as the user scrolls through text in the
TRichEdit component. Thisis necessary because text attributes in the TRichEdit component
can differ; thisis not the case with a TMemo component because attributes applied to a TMemo
component apply to the entire component.
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In functionality, the rich text editor form and the text editor form are, for the most part, very
similar. The main difference is that the rich text editor allows users to change the attributes for
separate paragraphs or selected text; the text editor is incapable of doing this.

The Bitmap Viewer—The Third MDI Child Form

The bitmap viewer enables the user to load and view Windows bitmap files. Like the other two
MDI child forms, the bitmap viewer form, TMdiBmpForm, is derived from the TMDIChildForm
base class. It contains a client-aligned TImage component.

TMdiBmpForm contains only its inherited TMainMenu component. Listing 16.4 shows the source
code that defines TMdiBmpForm.

LISTING 16.4  MdiBmpFrm.pas: A Unit Defining TMdiBmpForm

unit MdiBmpFrm;
interface

uses
SysUtils, Windows, Messages, Classes, Graphics, Controls, Forms, Dialogs,
MdiChildFrm, ExtCtrls, Menus, Buttons, ComCtrls, ToolWin, ImgList;

type
TMdiBMPForm = class(TMDIChildForm)
mmiEdit: TMenulItem;
mmiCopy: TMenuItem;
mmiPaste: TMenuItem;
imgMain: TImage;
procedure mmiCopyClick(Sender: TObject);
procedure mmiPasteClick(Sender: TObject);
procedure mmiPrintClick(Sender: TObject);
public
procedure OpenFile(FileName: string);
end;

var
MdiBMPForm: TMdiBMPForm;

implementation
uses ClipBrd, Printers;
{$R *.DFM}

procedure TMdiBMPForm.OpenFile(FileName: String);
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begin
imgMain.Picture.LoadFromFile(FileName);
Caption := FileName;

end;

procedure TMdiBMPForm.mmiCopyClick(Sender: TObject);
begin

inherited;

ClipBoard.Assign(imgMain.Picture);
end;

procedure TMdiBMPForm.mmiPasteClick(Sender: TObject);
{ This method copies the contents from the clipboard into imgMain }
begin
inherited;
// Copy clipboard content to imgMain
imgMain.Picture.Assign(ClipBoard);
ClientWidth := imgMain.Picture.Width;
{ Adjust clientwidth to adjust the scollbars }

VertScrollBar.Range := imgMain.Picture.Height;
HorzScrollBar.Range := imgMain.Picture.Width;
end;

procedure TMdiBMPForm.mmiPrintClick(Sender: TObject);
begin
inherited;

with ImgMain.Picture.Bitmap do
begin
Printer.BeginDoc;
Printer.Canvas.StretchDraw(Canvas.ClipRect, imgMain.Picture.Bitmap);
Printer.EndDoc;
end; { with }
end;

end.

There is not as much code for TMdiBmpForm as there was for the two previous forms. The File
menu items invoke the TMDIChildForm's event handlers just as the TMdiEditForm and
TMdiRtfForm File menu items do. The Edit menu items copy and paste the bitmap to and from
the Windows Clipboard, respectively. Before calling the TImage.Picture.Assign() method to
assign the Clipboard data to the TImage component. The TImage component recognizes both
the CF_BITMAP and CF_PICTURE formats as bitmaps.

263

1

»

SNOILVITddy

AN



Advanced Techniques

264 PART I

The Windows Clipboard

The Clipboard provides the easiest way for two applications to share information. It’s
nothing more than a global memory block that Windows maintains for any applica-
tion to access through a specific set of Windows functions.

The Clipboard supports several standard formats, such as text, OEM text, bitmaps,
and metafiles; it also supports other specialized formats. Additionally, you can extend
the Clipboard to support application-specific formats.

Delphi 5 encapsulates the Windows Clipboard with the global variable Clipboard of
type TClipBoard, making it much easier for you to use. The TClipBoard class is cov-
ered in detail in Chapter 17, “Sharing Information with the Clipboard.”

The Main Form

The main form is the form with which the user initially works to create or switch between
MDI child forms. This form is appropriately named MainForm. MainForm serves as the parent
to the text editor, bitmap viewer, and RTF editor MDI child forms.

TMainForm iS not a descendant of TMDIChildForm as are the other forms discussed so far in this
chapter. TMainForm has the FormStyle of fsMDIForm (the other three forms inherited the style
fsMDIChild from TMDIChild). TMainForm contains a TMainMenu component and a TOpenDialog
component. TMainForm also contains a toolbar that contains only one button. TMainForm’s
source code is shown in Listing 16.5.

LisTING 16.5 MdiMainForm.pas: A Unit Defining TMainForm

unit MainFrm;
interface

uses
WinTypes, WinProcs, Classes, Graphics, Forms, Controls, Menus,
StdCtrls, Messages, Dialogs, SysUtils, ComCtrls,
ToolWwin, ExtCtrls, Buttons, ImgList;

type
TMainForm = class(TForm)

mmMain: TMainMenu;
OpenDialog: TOpenDialog;
mmiFile: TMenultem;
mmiExit: TMenulItem;

N3: TMenultem;

mmiOpen: TMenuItem;
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mmiNew: TMenuItem; 1
mmiWindow: TMenuItem;

mmiArrangeIcons: TMenultem;

mmiCascade: TMenuItem;

mmiTile: TMenultem;

mmiCloseAll: TMenultem;

tlbMain: TToolBar;

ilMain: TImagelList;

tbFileOpen: TToolButton;

»
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{ File Event Handlers }

procedure mmiNewClick(Sender: TObject);
procedure mmiOpenClick(Sender: TObject);
procedure mmiExitClick(Sender: TObject);

{ Window Event Handlers }
procedure mmiTileClick(Sender: TObject);
procedure mmiArrangeIconsClick(Sender: TObject);
procedure mmiCascadeClick(Sender: TObject);
procedure mmiCloseAllClick(Sender: TObject);
public
{ User defined methods }
procedure OpenTextFile(EditForm: TForm; Filename: string);
procedure OpenBMPFile(FileName: String);
procedure OpenRTFFile(RTFForm: TForm; FileName: string);
end;

var
MainForm: TMainForm;

implementation
uses MDIBmpFrm, MdiEditFrm, MdiRtfFrm, FTypForm;

const
{ Define constants to represent file name extensions }
BMPExt = '.BMP'; // Bitmapped file
TextExt = ".TXT'; // Text file
RTFEXxt = '".RTF'; // Rich Text Format file
{$R *.DFM}

procedure TMainForm.mmiNewClick (Sender: TObject);
begin
{ Determine the file type the user wishes to open by calling the
GetFileType function. Call the appropriate method based on the
retrieved file type. }

continues
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case GetFileType of
mrTXT: OpenTextFile(nil, ''); // Open a text file.
mrRTF: OpenRTFFile(nil, ''); // Open an RTF file.
mrBMP :
begin
{ Set the default filter for OpenDialog1 for BMP files. }
OpenDialog.FilterIndex := 2;
mmiOpenClick(nil);
end;
end;
end;

procedure TMainForm.mmiOpenClick(Sender: TObject);
var
Ext: string[4];
begin
{ Call the appropriate method based on the file type of the file
selected from OpenDialogil }
if OpenDialog.Execute then
begin
{ Get the file's extension and compare it to determine the
file type the user is opening. Call the appropriate method and
pass in the file name. }
Ext := ExtractFileExt(OpenDialog.FileName);
if CompareStr(UpperCase(Ext), TextExt) = @ then
OpenTextFile(ActiveMDIChild, OpenDialog.FileName)
else if CompareStr(UpperCase(Ext), BMPExt) = @ then
OpenBMPFile (OpenDialog.FileName)
else if CompareStr(UpperCase(Ext), RTFExt) = @ then
OpenRTFFile (ActiveMDIChild, OpenDialog.FileName);
end;
end;

procedure TMainForm.mmiExitClick(Sender: TObject);
begin

Close;
end;

{ Window Event Handlers }
procedure TMainForm.mmiTileClick(Sender: TObject);
begin

Tile;

end;

procedure TMainForm.mmiArrangeIconsClick(Sender: TObject);
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begin 1
ArrangelIcons;
end;

»

procedure TMainForm.mmiCascadeClick(Sender: TObject);
begin

Cascade;
end;
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procedure TMainForm.mmiCloseAllClick(Sender: TObject);
var
i: integer;
begin
{ Close all forms in reverse order as they appear in the
MDIChildren property. }
for i := MdiChildCount - 1 downto @ do
MDIChildren[i].Close;
end;

{ User Defined Methods }
procedure TMainForm.OpenTextFile(EditForm: TForm; FileName: string);
begin
{ If EditForm is of a TEditForm type, then give the user the option
of loading the file contents into this form. Otherwise, create a
new TEditForm instance and load the file into that instance }
if (EditForm <> nil) and (EditForm is TMdiEditForm) then
if MessageDlg('Load file into current form?', mtConfirmation,
[mbYes, mbNo], @) = mrYes then
begin
TMdiEditForm(EditForm).OpenFile(FileName);
Exit;
end;
{ Create a new TEditForm and call its OpenFile() method }
with TMdiEditForm.Create(self) do
if FileName <> '' then
OpenFile(FileName)
end;

procedure TMainForm.OpenRTFFile (RTFForm: TForm; FileName: string);
begin
{ If RTFForm is of a TRTFForm type, then give the user the option
of loading the file contents into this form. Otherwise, create a
new TRTFForm instance and load the file into that instance }
if (RTFForm <> nil) and (RTFForm is TMdiRTFForm) then
if MessageDlg('Load file into current form?', mtConfirmation,

continues
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[mbYes, mbNo], @) = mrYes then begin
(RTFForm as TMdiRTFForm).OpenFile(FileName);
Exit;
end;
{ Create a new TRTFForm and call its OpenFile() method }
with TMdiRTFForm.Create(self) do
if FileName <> '' then
OpenFile(FileName);
end;

procedure TMainForm.OpenBMPFile(FileName: String);
begin
{ Create a new TBMPForm instances and load a BMP file into it. }
with TMdiBmpForm.Create(self) do
OpenFile(FileName);
end;

end.

TMainForm uses another form, FileTypeForm, of the type TFileTypeForm. Listing 16.6 shows
the source code for this form.

LISTING 16.6 The FTYPFORM.PAS Unit Defining TFileTypeForm

unit FTypForm;
interface

uses
SysUtils, Windows, Messages, Classes, Graphics, Controls,
Forms, Dialogs, StdCtrls, ExtCtrls, Buttons;

const
mrTXT = mrYesToAll+1;
mrBMP = mrYesToAll+2;
mrRTF = mrYesToAll+3;

type

TFileTypeForm = class(TForm)

rgFormType: TRadioGroup;

btnOK: TButton;

procedure btnOkClick(Sender: TObject);
end;
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var 1

FileTypeForm: TFileTypeForm;

»

function GetFileType: Integer;

implementation
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function GetFileType: Integer;
{ This function returns the file type selected by the user as
represented by one of the above defined constants. }
begin
FileTypeForm := TFileTypeForm.Create(Application);
try
Result := FileTypeForm.ShowModal;
finally
FileTypeForm.Free;
end;
end;

{$R *.DFM}

procedure TFileTypeForm.btnOkClick(Sender: TObject);
begin
{ Return the correct modal result based on the selected file type }
case rgFormType.ItemIndex of
0: ModalResult := mrTXT;
1: ModalResult := mrRTF;
2: ModalResult := mrBMP;
end;
end;

end.

TFileTypeForm is used to prompt the user for afile type to create. This form returns the
ModalResult based on which TRadioButton the user selected to indicate the type of file. The
GetFileType () function takes care of creating, showing, and freeing the TFileTypeForm
instance. This function returns the TFileTypeForm.ModalResult property. Thisform is not
automatically created and has been removed from the list of autocreated forms for the project.

TMainForm's toolbar contains only one button, which is used to open the initial child form.
When a child form becomes active, its toolbar replaces the main form’s toolbar. Thislogic is
handled by the onActivate event of the child form. TMainForm’s public methods
OpenTextFile(), OpenRTFFile(), and OpenBMPFile() are called from the event handler
TMainForm.mmiOpenClick (), which isinvoked whenever the user selects the File, Open menu.
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OpenTextFile () takes two parameters. a TForm instance and a filename. The TForm instance
represents the currently active form for the application. The reason for passing this TForm
instance to the openTextFile () method is so that the method can determine whether the TForm
passed to it is of the TMdiEditForm class. If SO, it's possible that the user is opening atext file
in the existing TMdiEditForm instance rather than creating a new TMdiEditForm instance. If a
TMdiEditForm instance is passed to this method, the user is prompted whether he or she wants
the text file to be placed into this TForm parameter. If the user replies no or the TMdiEditForm
parameter isnil, a new TMdiEditForm instance is created.

OpenRTFFile () operatesthe same asOpenTextFile() except that it checksfor a TRFTForm class
as the currently active form represented by the TForm parameter. The functionality is the same.

OpenBMPFile () always assumes that the user is opening a new file. Thisis because the
TMdiBmpForm is only aviewer and not an editor. If the form allowed the user to edit a
bitmapped image, the openBMPFile () method would function as do openTextFile() and
OpenRTFFile().

The mmiNewClick () event handler callsthe GetFileType() function to retrieve afile type from
the user. It then calls the appropriate openxxxFile () method based on the return value. If the
fileisa .omp file, the openDialog.Filter property is set to the BMP filter by default and the
mmiOpenClick () method isinvoked because the user is not creating anew .bmp file but is
opening an existing one.

The mmiopenclick () event handler invokes openDialog and calls the appropriate
OpenxxXFile() method. Notice that OpenTextFile () and OpenRTFFile() are passed the
TMainForm.ActiveMDIChild property as the first parameter. ActiveMbdIChild isthe MDI child
that currently has focus. Recall that both these methods determine whether the user wants to
open afileinto an existing MDI child form. If no forms are active, ActiveMDIChild iSnil. If
ActiveMDIChild is pointing to a TMdiRTFForm and OpenTextFile() iScalled, OpenTextFile()
still functions correctly because of this statement:

if (RTFForm <> nil) and (RTFForm is TMdiRTFForm) then

This statement determines whether ActiveMDIChild pointsto a TMdiRtfForm. If not, a new
form is created.

The event handler, mmiExitClick(), calls TMainForm.Close (); this method not only closes the
main form, it also terminates the application. If there are any child forms open at the time this
event handler is invoked, the child forms are also closed and destroyed.

The Window menu event handlers are single-line methods that affect how the MDI child forms
are arranged on the main form’s client area. Figures 16.2 and 16.3 show tiled and cascaded
forms, respectively.
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Cascaded child forms.

The mmiArrangeIconsClick() method simply rearranges the iconsin the main form’s client
area so that they’re evenly spaced and do not overlap.

ThemmiCloseAllClick () event handler closes al open MDI child forms. The loop that closes
the child forms loops through all child forms in reverse order as they appear in the MDIChildren
array property. TheMDIChildren property is azero-based array property of al MDI children
active in an application. The MDIChildCount property isthe number of children that are active.

This completes the discussion of the functionality of the MDI application. The following sec-
tions discuss some techniques and some of the components used with the various forms in the
application.
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Working with Menus

Using menus in MDI applications is no more difficult than using them in any other type of
application. However, there are some differences in how menus work in MDI applications. The
following sections show how an MDI application allows its child forms to share the same
menu bar using a method called menu merging. You also learn how to make non-MDI applica
tions share the same menu bar.

Merging Menus with MDI Applications

Take alook at the TMainMenu for the TMdiEditForm. By double-clicking the TMainMenu icon,
you bring up the menu editor.

TMdiEditForm’'s main menu contains three menu items along the menu bar. These items are
File, Edit, and Character. Each of these menu items has a GroupIndex property that shows up
in the Object Inspector as you click a menu item in the menu editor. Notice that the File menu
item has aGroupIndex value of 0. The Edit and Character menu items both have GroupIndex
values of 1.

Notice that TMainForm’s main menu has two menu items along its menu bar: File and Window.
Like TMdiEditForm, TMainForm's File menu item has aGroupIndex value of 0. The Window
menu item’s GroupIndex property, on the other hand, has a value of 9.

Also notice that the File menu for TMainForm and the File menu for TMdiEditForm have differ-
ent submenu items. TMdiEditForm’'s File menu has more submenu items than does TMainForm's
File menu.

The GroupIndex property isimportant because it allows menus of formsto be “merged.” This
means that when the main form launches a child form, the child form’s main menu is merged
with the main form’'s main menu. The GroupIndex property determines how the menus are
ordered and which menus of the main form are replaced by menus of the child form. Note that
menu merging applies only to menu items along the menu bar of a TMainMenu component and
not to submenus.

Whenever aGroupIndex property for achild form’s menu item has the same value as the
GroupIndex property for amenu item on the main form, the child form’s menu item replaces the
main form’'s menu item. The remaining menus are arranged al ong the menu bar in the order
specified by the GroupIndex properties of all combined menu items. When MdiEditForm isthe
active form in the project, the menu items that appear along the main form’s menu bar are File,
Edit, Character, and Window, in that order. Note that the File menu is TMdiEditForm’s File
menu because both File menus have GroupIndex property values of @. Therefore,
TMdiChildForm's File menu replaces TMainForm’s File menu. The order of these menus directly
reflects the order of the GroupIndex properties for each menu item along the menu bar: o, 1, 1, 9.
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Although we don’t use them here, there are certain numbering guidelines that you
should follow so that your applications will better integrate with OLE Container’s
menu merging. These guidelines are explained in the “Borland Delphi Library
Reference Guide.”
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This behavior is the same with the other forms in the MDI application. Whenever aform
becomes active, the menu along the main menu bar changes to reflect the merging of menus
for both the main form and child form. When you run the project, the menu bar changes
depending on which child form is active.

Merging menus with MDI applications is automatic. As long as the values of the menu items’
GroupIndex property is set in the order you specify, your menus merge correctly when you
invoke MDI child forms.

For non-MDI applications, the processis just as easy but requires an extra step. We gave a
quick example in Chapter 4, “Application Frameworks and Design Concepts,” on merging
menus in non-M DI applications when we discussed the TNavStatForm. However, in that appli-
cation, we based this merging on child forms that were actually child windows to a control,
other than the main form, and had to explicitly call the Merge () and unmerge () functions. For
merging menus with non—-MDI-based applications in general, this process is not automatic, as
it iswith MDI applications. You must set the AutoMerge property to True for the TMainMenu on
the form whose menus are to be merged with the main form. A sample project that shows
menu merging for non-MDI forms can be found in the project NonMDI . dpr on the CD.

Adding a List of Open Documents to the Menu

To add alist of open documents to the Window menu, set the windowMenu property of the main
form to the menu item’s instance that is to hold the list of open documents. For example, the
TMainForm.WindowMenu property in the sample MDI application is set to mmiwindow, which
refers to the Window menu along the menu bar. The selection you choose for this property
must be a menu item that appears on the menu bar—it cannot be a submenu. The application
displays alist of open documents in the Window menu.

Miscellaneous MDI Techniques

The following sections show various common techniques applicable to MDI applications.
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Drawing a Bitmap in the MDI Client Window

When designing an MDI application, you might want to place a background image, such as a
company logo, on the client area of an MDI application’s main form. For regular (non-MDI)
forms, this procedure is simple. You just place a TImage component on the form, set itsAlign
property to alClient, and you're done (refer back to the bitmap viewer in the MDI sample
application, earlier in this chapter). Placing an image on the main form of an MDI application,
however, is a different story.

Recall that the client window of an MDI application is a separate window from the main form.
The client window has many responsibilities of carrying out MDI-specific tasks, including the
drawing of MDI child windows.

Think of it as though the main form is a transparent window over the client window. Whenever
you place components such as TButton, TEdit, and TImage over the client area of the main
form, these components are actually placed on the main form’s transparent window. When the
client window performs its drawing of child windows—or rather child forms—the forms are
drawn underneath the components that appear on the main form, much like placing stickers on
the glass of a picture frame (see Figure 16.4).

[ Delphi 5 Developer's Guide MDI Application [-[O]x] I
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FIGURE 16.4
Client forms drawn underneath the main form's components.

So how do you go about drawing on the client window? Because Delphi 5 doesn't provide a
VCL encapsulation of the client window, you must use the Win32 API. The method used is to
subclass the client window and capture the message responsible for painting the client win-
dow’s background—wm_ERASEBKGND. There, you take over the default behavior and perform
your own custom drawing.
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The following code is from the project MdiBknd.dpr on the CD. This project is an MDI appli-
cation with aTImage component that contains a bitmap. From the menu, you can specify how
to draw the image on the MDI client window—centered, tiled, or stretched, as shown respec-

tively in Figures 16.5, 16.6, and 16.7.

it Delphi 5 Developer's Guide MDI Background Drawing Dema
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FIGURE 16.5
The MDI client window with a centered image.
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FIGURE 16.6

The MDI client window with a tiled image.
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i Delphi 5 Developer's Guide MDI Background Drawing Dema
FEile  Image
FIGURE 16.7

The MDI client window with a stretched image.

Listing 16.7 shows the unit code that performs the drawing.

LisTING 16.7 Drawing Images on the MDI Client Window

unit MainFrm;
interface

uses Windows, SysUtils, Classes, Graphics, Forms, Controls, Menus,
StdCtrls, Dialogs, Buttons, Messages, ExtCtrls, JPeg;

type

TMainForm = class(TForm)
mmMain: TMainMenu;
mmiFile: TMenuItem;
mmiNew: TMenuItem;
mmiClose: TMenuItem;
N1: TMenultem;
mmiExit: TMenulItem;
mmiImage: TMenuItem;
mmiTile: TMenuItem;
mmiCenter: TMenuItem;
mmiStretch: TMenuItem;
imgMain: TImage;
procedure mmiNewClick(Sender: TObject);
procedure mmiCloseClick(Sender: TObject);
procedure mmiExitClick(Sender: TObject);
procedure mmiTileClick(Sender: TObject);
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private
FOldClientProc,
FNewClientProc: TFarProc;
FDrawDC: hDC;
procedure CreateMDIChild(const Name: string);
procedure ClientWndProc(var Message: TMessage);
procedure DrawStretched;
procedure DrawCentered;
procedure DrawTiled;
protected
procedure CreateWnd; override;
end;

var
MainForm: TMainForm;

implementation
uses MdiChildFrm;
{$R *.DFM}

procedure TMainForm.CreateWnd;
begin
inherited CreateWnd;
// Turn the ClientWndProc method into a valid window procedure
FNewClientProc := MakeObjectInstance(ClientWndProc);
// Get a pointer to the original window procedure
FOldClientProc := Pointer(GetWindowLong(ClientHandle, GWL_WNDPROC)) ;
// Set ClientWndProc as the new window procedure
SetWindowLong(ClientHandle, GWL_WNDPROC, LongInt(FNewClientProc));
end;

procedure TMainForm.DrawCentered;
{ This procedure centers the image on the form's client area }
var
CR: TRect;
begin
GetWindowRect(ClientHandle, CR);
with imgMain do
BitBlt (FDrawDC, ((CR.Right - CR.Left) - Picture.Width) div 2,
((CR.Bottom - CR.Top) - Picture.Height) div 2,
Picture.Graphic.Width, Picture.Graphic.Height,
Picture.Bitmap.Canvas.Handle, @, @, SRCCOPY);
end;

continues
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LisTING 16.7 Continued

procedure TMainForm.DrawStretched;
{ This procedure stretches the image on the form's client area }
var

CR: TRect;

begin

GetWindowRect (ClientHandle, CR);

StretchBlt(FDrawDC, @, 0, CR.Right, CR.Bottom,
imgMain.Picture.Bitmap.Canvas.Handle, 0, 0,
imgMain.Picture.Width, imgMain.Picture.Height, SRCCOPY);

end;

procedure TMainForm.DrawTiled;
{ This procedure tiles the image on the form's client area }
var
Row, Col: Integer;
CR, IR: TRect;
NumRows, NumCols: Integer;
begin
GetWindowRect(ClientHandle, CR);
IR := imgMain.ClientRect;
NumRows := CR.Bottom div IR.Bottom;
NumCols := CR.Right div IR.Right;
with imgMain do
for Row := 0 to NumRows+1 do
for Col := @ to NumCols+1 do
BitBlt(FDrawDC, Col * Picture.Width, Row * Picture.Height,
Picture.Width, Picture.Height, Picture.Bitmap.Canvas.Handle,
@, 0, SRCCOPY);
end;

procedure TMainForm.ClientWndProc(var Message: TMessage);
begin
case Message.Msg of
// Capture the WM_ERASEBKGND messages and perform the client area drawing
WM_ERASEBKGND :
begin
CallWindowProc (FOldClientProc, ClientHandle, Message.Msg,
Message.wParam,
Message.lParam);
FDrawDC := TWMEraseBkGnd(Message) .DC;
if mmiStretch.Checked then
DrawStretched
else if mmiCenter.Checked then
DrawCentered
else DrawTiled;
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Message.Result := 1;
end;
{ Capture the scrolling messages and ensure the client area
is redrawn by calling InvalidateRect }
WM_VSCROLL, WM_HSCROLL:
begin
Message.Result := CallWindowProc(FOldClientProc, ClientHandle,
Message.Msg,
Message.wParam, Message.lParam);
InvalidateRect(ClientHandle, nil, True);
end;
else
// By Default, call the original window procedure
Message.Result := CallWindowProc(FOldClientProc, ClientHandle,
Message.Msg,
Message.wParam, Message.lParam);
end; { case }
end;

procedure TMainForm.CreateMDIChild(const Name: string);
var
MdiChild: TMDIChildForm;
begin
MdiChild := TMDIChildForm.Create(Application);
MdiChild.Caption := Name;
end;

procedure TMainForm.mmiNewClick (Sender: TObject);
begin

CreateMDIChild( 'NONAME' + IntToStr(MDIChildCount + 1));
end;

procedure TMainForm.mmiCloseClick(Sender: TObject);
begin
if ActiveMDIChild <> nil then
ActiveMDIChild.Close;
end;

procedure TMainForm.mmiExitClick(Sender: TObject);
begin

Close;
end;

procedure TMainForm.mmiTileClick(Sender: TObject);
begin
mmiTile.Checked := false;

CHAPTER 16
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mmiCenter.Checked := False;
mmiStretch.Checked := False;
{ Set the Checked property for the menu item which invoked }
{ this event handler to Checked }
if Sender is TMenulItem then

TMenuItem(Sender).Checked := not TMenulItem(Sender).Checked;
{ Redraw the client area of the form }
InvalidateRect(ClientHandle, nil, True);

end;

end.

To paint the image to the client window of the MDI application, you must use a technique
called subclassing. Subclassing is discussed in Chapter 5, “Understanding Messages.” To sub-
class the client window, you must store the client window’s original window procedure so that
you can call it. You must also have a pointer to the new window procedure. The form variable
FoldClientProc storesthe origina window procedure, and the variable FNewClientProc
points to the new window procedure.

The procedure ClientWndProc () isthe procedure to which FNewClientProc points. Actually,
because c1ientWndProc () isamethod of TMainForm, you must use the
MakeObjectInstance() function to return a pointer to a window procedure created from the
method MakeObjectInstance (), asdiscussed in Chapter 13, “Hard-core Techniques”

The TMainForm.Createwnd () method was overridden when the main form’s client window was
subclassed by using the GetWindowLong () and SetWindowLong () Win32 API functions.
ClientWndProc() isthe new window procedure.

TMainForm contains three private methods: DrawCentered(), DrawTiled(), and
DrawStretched (). Each of these methods uses Win32 API functions to perform the GDI draw-
ing routines to paint the bitmap. Win32 API functions are used because the client window's
device context isn't encapsulated by Tcanvas, so you can't normally use the built-in Delphi 5
methods. Actually, it's possible to assign the device context to a TCanvas.Handle property. You
would have to instantiate a Tcanvas instance in order to do this, but it is possible.

You must capture three messages to perform the background drawing: WM_ERASEBKGND,
WM_VSCROLL, and WM_HSCROLL. The wM_ERASEBKGND message is sent to a window when it's to be
erased. Thisis an opportune time to perform the specialized drawing of the image. In the pro-
cedure, you determine which drawing procedure to call based on which menu item is selected.
Thewm_vSscRoLL and WM_HSCROLL messages are captured to ensure that the background image
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is properly drawn when the user scrolls the main form. Finally, al other messages are sent to 1
the original window procedure with this statement:

»

Message.Result := CallWindowProc(FOldClientProc, ClientHandle, Message.Msg,
Message.wParam, Message.lParam);

This example not only demonstrates how you can visually enhance your applications; it also
shows how you can perform API-level development with techniques not provided by the VCL.

SNOLLYOITdd/
AN

Creating a Hidden MDI Child Form

Delphi 5 returns an error if you ever attempt to hide an MDI child form using a statement such
as this one:

ChildForm.Hide;

The error indicates that hiding an MDI child form is not allowed. The reason for thisis
because the Delphi developers found that in the Windows implementation of MDI, hiding MDI
child forms corrupts the z-order of the child windows. Unless you're extremely careful about
when you use such a technique, trying to hide an MDI child form can wreak havoc with your
application. Nevertheless, you might have the need to hide a child form. There are two waysin
which you can hide MDI child forms. Just be aware of the anomaly and use these techniques
with caution.

One way to hide an MDI child form is to prevent the client window from drawing the child
form altogether. Do this by using the LockwindowUpdate () Win32 APl function to disable
drawing to the MDI client window. This technique is useful if you want to create an MDI child
form but don’'t want to show that form to the user unless some process has completed success-
fully. For example, such a process might be a database query; if the process fails, you might
want to free the form. Unless you use some method to hide the form, you'll see aflicker on the
screen as the form is created before you have an opportunity to destroy it. The
LockWindowUpdate () function disables drawing to a window’s canvas. Only one window can
be locked at any given time. Passing @ to LockWindowUpdate reenables drawing to the win-
dow’s canvas.

The other method of hiding an MDI child form isto actually hide the child form by using the
Win32 API function showwindow (). You hide the form by specifying the sw_HIDE flag along
with the function. You must then use the setwindowPos () function to restore the child window.
You can use this technique to hide the MDI child form if it's already created and displayed to
the user.

Listing 16.8 illustrates the techniques just described and is the main form for the project
MdiHide.dpr on the CD.
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LISTING 16.8 A Unit Showing MDI Child Form-Hiding Techniques

unit MainFrm;
interface

uses Windows, SysUtils, Classes, Graphics, Forms, Controls, Menus,
StdCtrls, Dialogs, Buttons, Messages, ExtCtrls, ComCtrls, MdiChildFrm;

type
TMainForm = class(TForm)
mmMain: TMainMenu;
mmiFile: TMenuItem;
mmiNew: TMenuItem;
mmiClose: TMenuItem;
mmiWindow: TMenuItem;
N1: TMenultem;
mmiExit: TMenuItem;
mmiHide: TMenuItem;
mmiShow: TMenuItem;
mmiHideForm: TMenuItem;
procedure mmiNewClick(Sender: TObject);
procedure mmiCloseClick(Sender: TObject);
procedure mmiExitClick(Sender: TObject);
procedure mmiHideClick(Sender: TObject);
procedure mmiShowClick(Sender: TObject);
procedure mmiHideFormClick (Sender: TObject);
private
procedure CreateMDIChild(const Name: string);
public
HideForm: TMDIChildForm;
Hidden: Boolean;
end;

var
MainForm: TMainForm;

implementation
{$R *.DFM}

procedure TMainForm.CreateMDIChild(const Name: string);
var
MdiChild: TMDIChildForm;
begin
MdiChild := TMDIChildForm.Create(Application);
MdiChild.Caption := Name;
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end;

procedure TMainForm.mmiNewClick (Sender: TObject);
begin

CreateMDIChild( 'NONAME' + IntToStr(MDIChildCount + 1));
end;

procedure TMainForm.mmiCloseClick(Sender: TObject);
begin
if ActiveMDIChild <> nil then
ActiveMDIChild.Close;
end;

procedure TMainForm.mmiExitClick(Sender: TObject);
begin

Close;
end;

procedure TMainForm.mmiHideClick(Sender: TObject);
begin
if Assigned(HideForm) then
ShowWindow(HideForm.Handle, SW_HIDE);
Hidden := True;
end;

procedure TMainForm.mmiShowClick (Sender: TObject);
begin
if Assigned(HideForm) then
SetWindowPos (HideForm.handle, HWND_TOP, @0, 0, 0, @, SWP_NOSIZE
or SWP_NOMOVE or SWP_SHOWWINDOW) ;
Hidden := False;
end;

procedure TMainForm.mmiHideFormClick(Sender: TObject);
begin
if not Assigned(HideForm) then
begin
if MessageDlg('Create Hidden?', mtConfirmation, [mbYes, mbNo], @) = mrYes
then

begin
LockWindowUpdate (Handle);
try
HideForm := TMDIChildForm.Create(Application);
HideForm.Caption := 'HideForm';
ShowMessage('Form created and hidden. Press OK to show form');
finally

continues
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LockWindowUpdate (Q);

end;

end

else begin
HideForm := TMDIChildForm.Create(Application);
HideForm.Caption := 'HideForm';

end;

end

else if not Hidden then
HideForm.SetFocus;
end;

end.

The project isa simple MDI application. The event handler mmiHideFormClick () createsa
child form that can either be created and hidden or hidden by the user after it's displayed.

When mmiHideFormClick () isinvoked, it checks whether an instance of THideForm has been
created. If so, it displays only the THideForm instance, provided that it has not been hidden by
the user. If there is no instance of THideForm present, the user is prompted whether it should be
created and hidden. If the user responds affirmatively, drawing to the client window is disabled
before the form is created. If drawing to the client window is not disabled, the form isdis-
played as it's created. The user is then shown a message box indicating that the form is cre-
ated. When the user closes the message box, drawing to the client window is reenabled and the
child form is displayed by forcing the client window to repaint itself. You can replace the mes-
sage box telling the user that the form is created with some lengthy process that requires the
child form to be created but not displayed. If the user chooses not to create the form as hidden,
it's created normally.

The second method used to hide the form after it has already been displayed calls the Win32
API function showwindow () and passes the child form’s handle and the sw_HIDE flag. This
effectively hides the form. To redisplay the form, call the Win32 API function SetWindowPos (),
using the child form’s handle and the flags specified in the listing. SetWindowPos () is used to
change awindow’s size, position, or z-order. In this example, SetWindowPos () isused to redis-
play the hidden window by setting its z-order; in this case, the z-order of the hidden form is set
to be the top window by specifying the HWND_ToP flag.

Minimizing, Maximizing, and Restoring
All MDI Child Windows

Often, you need to perform atask across all active MDI forms in the project. Changing the
form'swindowState property is atypical example of a process to be performed on every
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instance of an MDI child form. This task is quite simple and only requires that you walk
through the forms using the main form’sMpIChildren array property. The main form’s
MDIChildren property holds the number of active MDI child forms. Listing 16.9 shows the
event handlers that minimize, maximize, and restore all MDI child windows in an application.
This project can be found on the CD astheMin_Max.dpr project.

LISTING 16.9 Minimizing, Maximizing, and Restoring All MDI Child Forms

unit MainFrm;
interface

uses Windows, SysUtils, Classes, Graphics, Forms, Controls, Menus,
StdCtrls, Dialogs, Buttons, Messages, ExtCtrls, ComCtrls;

type
TMainForm = class(TForm)
MainMenul: TMainMenu;
mmiFile: TMenuItem;
mmiNew: TMenuItem;
mmiClose: TMenuItem;
mmiWindow: TMenuItem;
N1: TMenultem;
mmiExit: TMenuItem;
mmiMinimizeAll: TMenultem;
mmiMaximizeAll: TMenultem;
mmiRestoreAll: TMenultem;
procedure mmiNewClick(Sender: TObject);
procedure mmiCloseClick(Sender: TObject);
procedure mmiExitClick(Sender: TObject);
procedure mmiMinimizeAllClick(Sender: TObject);
procedure mmiMaximizeAllClick(Sender: TObject)
procedure mmiRestoreAllClick(Sender: TObject);
private
{ Private declarations }
procedure CreateMDIChild(const Name: string);
public
{ Public declarations }
end;

H

var
MainForm: TMainForm;

implementation
uses MdiChildFrm;
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{$R *.DFM}

procedure TMainForm.CreateMDIChild(const Name: string);
var
Child: TMDIChildForm;
begin
Child := TMDIChildForm.Create(Application);
Child.Caption := Name;
end;

procedure TMainForm.mmiNewClick (Sender: TObject);
begin

CreateMDIChild( 'NONAME' + IntToStr(MDIChildCount + 1));
end;

procedure TMainForm.mmiCloseClick(Sender: TObject);
begin
if ActiveMDIChild <> nil then
ActiveMDIChild.Close;
end;

procedure TMainForm.mmiExitClick(Sender: TObject);
begin

Close;
end;

procedure TMainForm.mmiMinimizeAllClick(Sender: TObject);

var
i: integer;
begin
for i := MDIChildCount - 1 downto @ do
MDIChildren[i] .WindowState := wsMinimized;
end;

procedure TMainForm.mmiMaximizeAllClick(Sender: TObject);

var
i: integer;
begin
for i := 0 to MDIChildCount - 1 do
MDIChildren[i].WindowState := wsMaximized;
end;

procedure TMainForm.mmiRestoreAllClick(Sender: TObject);
var
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i: integer;
begin 1
for i := @ to MDIChildCount - 1 do
MDIChildren[i].WindowState := wsNormal;
end;

»

end.

SNOILVITddy

Summary

This chapter showed you how to build MDI applications in Delphi 5. You a so learned some
advanced techniques specific to MDI applications. With the foundation you received in this
chapter, you should be well on your way to creating professional-looking MDI applications.
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